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1. Activation 

Activation using Windows  

Upon starting HDR projects 2018 professional for the first time, you will 

be prompted to activate the program. Proceed as follows:  

Install HDR projects 2018 professional as described by the installation 

instructions.    

Input your serial number. For the box version, this can be found on the 

accompanying booklet. If you have chosen to download the program, you 

will have received the serial number by email directly following your pur-

chase.    

 

Finally, click on the “Activate” button. The software has now been suc-

cessfully activated!  
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Activation using Mac  

Upon starting HDR projects 2018 professional for the first time, you will 

be prompted to activate the program. Proceed as follows:  

Install HDR projects 2018 professional as described by the installation 

instructions.    

Input your serial number. For the box version, this can be found on the 

accompanying booklet. If you have chosen to download the program, you 

will have received the serial number by email directly following your pur-

chase.    

 

Finally, click on the “Activate” button. The software has now been suc-

cessfully activated!  

Note: HDR projects 2018 professional can be installed on up to two 

computers using the same serial number.   

A second serial number is not necessary. When installing the program on 

a second device, simply enter the serial number again and press “Acti-

vate”.   
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2. Fascinating High Dynamic Range Photo-

graphy 

Even the most modern digital cameras have a limited dynamic range. 

Drastic lighting contrasts exhibit this restriction easily, such as with a 

photo taken indoors looking outside, like in the first example shot. You 

either have a properly lit interior, where the surrounding park behind the 

arches are far too bright, or an image with an adequately lit park, but with 

an interior that is far too dark.   

HDR technology, short for High Dynamic Range, clears up this problem 

by generating images with an extremely large dynamic range, unmatcha-

ble by monitor displays or prints.  

The idea is simple - several images with varying exposure times are 

assembled into one image. In our example, three shots are fused: an 

image with a longer exposure time to capture the dark details inside the 

pavilion, a short exposure shot where the park behind the pavilion is 

correctly lit, as well as an exposure exactly in the middle.     

 

   

 

The combined result is a single image containing all of the light, midtone 

and shadow detail. HDR projects 2018 professional does the work for 

you. The capable program merges the bracketing exposure images and 

uses tone mapping to establish a photo fit for printing and screen dis-

plays. 
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The combined image contains all of the details of the pavilion and park, 

properly lit just as we saw the scene with our own eyes.    

In the next few pages we will show you how quickly you can create fasci-

nating images with HDR projects 2018 professional and what you can 

achieve with its immense range of functions.   

An obvious case for HDR projects 2018 professional - an evening 

scene with lanterns can only be captured naturally using HDR technolo-

gy. Otherwise, the dark surroundings would not be capturable with the 

bright lights. A camera sensor's range of contrast is very limited when 

compared to that of the human eye.    
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All of the details are realistically depicted in the fused photo.   

Tip: Always capture your bracketing series with different exposure times, 

not just with different blending values. Merging the images requires an 

identical depth of focus for all of the individual shots. 
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3. What´s New? 

HDR projects 2018 professional offers many new features. Here is an 

overview of some of the most important developments: 

 

 5 different HDR Styles affecting all Presets  

 

 

 New Module: Textures and materials for selective painting  

 Integrated Print Function including automatic image centering 

and scaling according to your selected print medium  

 New Compare Window with Zoom Function  

 Image Scaling when uploading exposure brackets (25% to 

400%)  

 

 New Max. Image Count: 100 images in an exposure bracket 
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 Color Normalization of Image Files: HDR Preparation now in-

cludes a new automatic Color Normalization capability. This au-

tomatically removes common color faults that occur when up-

loading image files. (Keyword: Rot Cast with Canon, Green Cast 

with Nikon, …) 

 

 

 New Mode in Intelligent Color Space (SCA) -> „Contour Protec-

tion”  

 4 New Variations in the Optimization Assistant  

 

 Global Reset Functions in the Menu under “Extras”  

 

 5 New Allocation Methods  

 

 New Selective Painting Effects and Functions  

 
 New Expert-Function “Result to Original”  

 

 Editing Results can be posted to the clipboard  

 

 12 New Post-Processing Effects  
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 New Effect Category “Smart Mask Filter”  

 

 Individual Brush Parameters with adjusted default values in Se-

lective Painting  

 
 16-Bit and 32-Bit Image File Format support maximum resolu-

tion up to 714 Megapixels  

 
 Source Image Mirroring Function for Composing in Selective 

Painting  

 

 3 New Effects in the RAW Module: Color noise removal, Gauss-

Blur, Aura  

 
 Central Auxiliary Line in the RAW Module  

 
 Enhanced precision in arrangement and display of the Progress 

Bar 
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New Automations:  

 Automatic File Save with or without cropping edits  

 Automatic File Save in maximum resolution   

 Automatic Grain Engine reset capabilities  

 File Save extensions added to the file name in batch-processing 

can now be optionally deactivated  

 Information dialogues display on/off  

 Automatic Denoise Optimization on/off  
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New RAW Formats  

 

 BlackMagic URSA Mini 4k, URSA Mini 4.6k, URSA Mini Pro 4.6k 

 Canon PowerShot G9 X Mark II, EOS 6D Mark II, 77D, 200D, 800D, 

EOS M 

 FujiFilm X-A3, X-A10 

 GITUP GIT2P 

 Leica TL2 

 Nikon D7500 

 Olympus TG-5 

 OnePlus A5000 

 Panasonic DC-GH5, DC-ZS70 (DC-TZ90/91/92, DC-T93) 

 PARROT Bebop 2, Bebop Drone 

 Pentax KP 

 Sony A9 

 Yi M1 

 YUNEEC CGO3, CGO3P 
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4. Configuring The User Interface 

Optional font size for Menus and titles 

In the main menu of the program you will find in View -> font size an 

option to customise the size of the letters in the menu as well as in the 

titles of the programm. 

 

The font size can be adjusted to the run time of the program.  

4K – monitors gives you the option to enlarge the font size for better 

readability of the menu. 
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5. HDR Photos Done Quickly  

You can obtain a finished HDR image in just 5 clicks with HDR projects 

2018 professional.    

1. Load Images   

2. HDR Preparation  

3. Post-Processing  Select HDR Style   Preset Selection   

4. Optimisation Assistant   

5. Select Image segment and Save, that´s it! 

 

You can simply drag and drop your images or bracketing series 

onto the start screen    

 

How to get the results you want, and fast - the elaborated presets and 

looks, individual image adaption and selected drawing allows you to go 

down your own creative route. HDR projects 2018 professional offers 

both options.    

 



HDR projects 2018 professional – User manual 

 

16 

At the top of the screen are the main menu as well as the menu bar. This 

menu bar contains the following functions (from left to right): 

 

o Image data Browser     

 

o Progress Browser    

  
 

o Upload image      

 

o Open project      

 

o Batch processing      

 

Optionally image data can also simply be „dropped“ onto the screen by 

Drag & Drop. Then the image data is uploaded automatically. 

 

6. Importing Image Material 

To load a single image or a bracketing series, simply drag and drop the 

images onto the start screen. Alternatively, you can also use the toolbar 

buttons or drop-down file menu.    

 

 

The maximum number of possible exposures of a bracketing series is 

100 pictures in HDR projects 2018 professional. 

 

 



HDR projects 2018 professional – User manual 

 

17 

 

How does this number come about? 

A HDR- photograph (High Dynamic Range) differentiates from other 

photographs through one major characteristic: 

The information of 32 exposure levels (32 Bit/ 32 ev) can be saved in one 

image. 

These 32 exposure levels (32 Bit/32 ev) are made up of the accuracy of 

RAW images with 14 exposure levels (14 Bit/ 14 ev) as well as the expo-

sure differences throughout the bracketing series. 

Let´s take for example a bracketing series that was taken with -2ev, 0ev, 

and +2ev. Which has as a result the dynamic range of +2-(-2) = 4 ev as 

exposure difference. This plus the 14 exposure levels from RAW, has a 

total of 18 ev exposure levels (18 Bit/18ev). 

55 Images are already sufficient to exactly replicate a bracketing series 

from -9 ev to +9 ev with intervals of 1/3 ev between two images. This 

ensures that you have used the maximum exposure that you can get out 

of a very good camera. 

Adjusting the +/- exposure value controls on your camera to posi-

tive/negative values will allow you to generate additional exposures for 

your standard exposure bracket.  

 

The HDR preparation dialog will open as soon as an image or a bracket-

ing series has been selected or dragged and dropped into the program. 

Here you can choose if you want to see the dialog each time you upload 

a bracketing series (click on the box at the bottom). 
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 Bracketing series browser 

For a better overview of your bracketing series you can use the 

bracketing series browser before uploading your bracketing se-

ries. 

Click on the corresponding symbol in the task bar. A preview 

window will open. Chose by „quell folder” your bracketing series 

folder. 

 

HDR projects 2018 professional starts immediately with the 

calculation, fitting automatically the right images together as well 

as showing a preview image. If you go across the image with the 

mouse, the image will automatically enlarge itself. 

The file type-filter is practical here, since one often has jpg 

rows and RAW images together in one folder. But if you type in 
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RAW in the file type, only the RAW rows will be shown. You 

won´t have any doubles any more. 

At 100% the search for images is finished. 

From this point on you will be able to upload the desired bracketing se-

ries. Click on the desired row with a right mouse click and chose in the 

context menu “open as project”. 

 

 

 

HDR projects 2018 professional uploads the images of the desired 

row and just like the simple Drag &Drop of the images on the desktop we 

start now with HDR preparation. 
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7. Menu Bar  

7.1 File 

 

File →  Start   

When you are finished editing an image or 

would like to close your current image, click-

ing on Start (or Ctrl  + N) will close the image 

currently open.  

 

File → Import Exposure Bracketing   

In order to open an image, click on Import Exposure Bracketing (or Ctrl  + Shift 

+ O) … to search for the exposure bracket you would like to edit.  

 

File → Exposure Bracketing Browser  

Select your bracket folder from within the “Source-Folder”. HDR projects 2018 

professional immediately begins its calculation process and automatically gath-

ers the best photos from your bracketed series. From here you can then upload 

your preferred exposure bracket.  

 

File → History Browser   

Clicking here will provide you with an overview of your separate projects and allow 

you to choose between them.  

 

File → Save Final Image   

If you are content with your editing results and would like to save your image, click 

on Save Final Image (or Ctrl  + S) … 
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File → Open Final Image in External Program   

If you would like to continue editing your current image in another program, you 

don’t even need to leave HDR projects 2018 professional. For this, simply click 

on Open Final Image in External Program.  

 

File → Export Exposure Bracketing  

Select Export Exposure Bracketing in order to save your edited exposure 

bracket and open it in an external program.  

 

File → Print Final Image  

Click here to print your final image. The image is automatically and correctly 

scaled to the print medium.  

 

File → Final Image Into Clipboard   

The final image is posted to the clipboard. You can then seamlessly insert it into 

other programs.  

 

File → Projects  

If you’ve already begun a project in HDR projects 2018 professional and would 

like to continue editing, open the file by clicking on Projects.  

 

File → Exit  

Click on Exit (or Ctrl  + F4) to close HDR projects 2018 professional.  
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7.2 Editing 

 
 
Edit → RAW Processing  

Whenever you want to easily edit a photo, simply click on RAW Processing to do 

things like alter colors in the photo or distort the image (please see 18. RAW Im-

age Editing)  

 

Edit → Edit Exposure Bracketing  

HDR projects 2018 professional utilizes a complex process to filter out all accu-

rately exposed pixels and combine them into one image (please see 11. HDR 

Creation and RAW Image Editing).  

 

Edit → Edit Weightings  

The Weight Painter is a tool used for manually editing individual HDR images in a 

series in order to selectively alter specific regions of the photograph. (Please see 

14. Edit Weighting with HDR Painter).  

 

Edit → Post-Processing  

Once you have edited or removed noise from an image, you find yourself in Post-

Processing Mode.    
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7.3 View 

 

View → Information Windows  

This window displays all exposure bracket information regarding the preset set-

tings.  

 

View → EXIF Information Window  

This window shows you (if available) all image file EXIF information such as loca-

tion, camera type, exposure duration and capture time.  

 

View → Histogram  

The histogram provides you with a consolidated overview of the Light Distribu-

tion Information present within your photo. This makes it easy to recognize if 

your photo is over/ underexposed.  

 

View → Full Screen View On/Off  

If you ever feel distracted by the task bar, you can toggle between a normal and 

full screen view by clicking on Full Screen View On/Off.  
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View → Interface-Style… (dark gray)  

Clicking on Interface Style... will allow you to alter the color scheme for HDR 

projects 2018 professional. The color scheme you have currently selected will 

appear in brackets.  

 

View → Font Size …  

Change the font size levels between small, medium and large. 

 

View → Frame Color: Gray Cart → automatic  

If you click on Frame Color: Gray Cart, the program will set the your image’s 

average color value as the frame color.  

 

View → Restore Window defaults   

Returns the current window to its original size.  

 

7.4 Extras 
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Extras → Batch Processing (HDR + Tonemapping)… (Ctrl  + B)  

Batch Processing in HDR projects 2018 professional enables the automatic 

processing of multiple bracketed series.  

 

Extras → Batch Processing (HDR-Fusion)…  

Batch Processing in HDR-Fusion lets you hand-select your own series for fusion of 

the HDR images into one, this without having to apply any Post Processing or 

Tonemapping filters. 

 

Extras → HDR Preparation…  

Here you can begin to prepare your images prior to HRD Creation (please see 8. 

HDR Preparation)  

 

Extras → Benchmark  

If you would like to know how quickly your PC can remove noise from your images, 

Benchmark is the function to choose. The programs will render five different 

images in real-time and provides you with an evaluation on a five-star scale.  

 

Extras → Settings (Ctrl  + P)  

Here you will find the various configuration options adaptable to your unique pref-

erences offered in HDR projects 2018 professional. 

 

Extras → Reset  

This returns the current user interface to its original size.  
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Extras → Create Restore Point (Shift + Z)  

If you would like to save your image in its current state and continue editing without 

initiating a file-save, simply select the option Create Restore Point or (Shift + Z). 

This allows you to return to the last saved state of your image at any time. 

 

Extras → Timeline (Ctrl  + T)  

Click on the Timeline or (Ctrl  + T) to display all saved Undo-Points.  

 

7.5 Add-ons 

 

 

Add-ons → Import Add-on  

With the help of Add-ons, you can now not only import Presets into HDR projects 

2018 professional but also integrate new Post Processing Modules that provide 

your Presets with an entirely new look.  

 

Add-ons → Remove Add-on  

This button lets you remove add-ons. 

 

Add-ons → Add-on Information  

Here you are provided with a display of all information regarding currently active 

Add-ons.  
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7.6 Information 

 

Informationen → HDR projects – Homepage  

Click here to navigate to the HDR projects 2018 professional homepage.  

 

Information → Show Shortcuts…  

Here you will find all keyboard shortcuts available in HDR projects 2018 profes-

sional.  

 

Information → Supported RAW Formats…  

A list of all cameras whose RAW Files are able to be opened in HDR projects 

2018 professional.  

 

Information →  Check For Updates  …  

This checks online whether newer versions of the software are available for down-

load.  

 

Information → About HDR projects (Shift + F1)  

Information about the current version, 3rd-Party Software and Credits from HDR 

projects 2018 professional.  
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8. HDR-Preperation 

Here you can precisely configure the program’s settings.   

For the first steps, please use the standard settings. These default set-

tings can be restored with the arrow at the bottom left. Nothing can be 

irretrievably adjusted.    
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a. Scaling: When bracketed series are uploaded, the images can 

be scaled from 25% up to 400% using any one of 6 different 

available Scaling Processes. 

b. Colour space conversion: advanced users can choose a col-

our space here - for all other users, it is recommended to not 

make any adjustments, to 

avoid incorrect colour ren-

dering later.  zu vermeiden. 

HDR projects 2018 pro-

fessional offers several 

new colour spaces (D65). 

The standard illuminant 

D65 is representative for a 

phase of natural daylight 

with the colour temperature 

of 6500° Kelvin. 

 

c. White balance: corrects colour casts that occur with shots tak-

en, for example, in a warmly lit room. To start, leave this setting 

unchanged.    

 
d. With this regulator one can adjust the colour temperature 

when you´re already uploading. It is advised that you leave the 

setting on “default” and to regulate the colour temperature later 

in post-processing. 
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e. Options: The automatic brilliance optimisation for RAW files 

can be activated in image preperation under RAW options. Fre-

quently it is with camera RAW formats that the image data will 

not use all tonal values that are available. The automatic bril-

liance optimisation compensates this with the uploaded RAW 

images by amplifying the tonal values so that a meaningful uti-

lised histogram is created for every camera RAW image. 

 

In the area for bracketing series this option is only wise, if you 

create HDR images from a single RAW. 

 

f. Noise suppression: these buttons allow you to select the pre-

cision of the noise removal, and the slider regulates the degree 

of the sharpness for the edges. Here dark images can undergo 

significant noise removal and have hot pixels (light spots caused 

by the camera’s sensor in dark situations) eliminated. 

 

g. Exposure: can be chosen if an image in a bracketing series is 

improperly lit and/or blurry, and must therefore be supplement-

ed by the program. With a dark bracketing series, it is recom-

mended to use the “Optimise dark areas” function to remove 

any colour casts. Light areas and details can also be optimised 

for bright bracketing series. 
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h. Alignment: here you can influence how the individual images of 

the series are congruently positioned on top of one another. The 

subtlest movement of an object, unintentional zooming or rotat-

ing of the camera can be considered. In the majority of cases, 

the default settings often lead to the preferred result. 

 

i. Automatic ghosting correction: HDR projects 2018 profes-

sional uses a highly precise ghosting removal to filter out sub-

jects and people moving within the bracketing series. Without 

correction the people or vehicles in the final image would ap-

pear half transparent several times and create a complete jum-

ble.   

 

 

 

 

 

 

 

 

 

 

Fusing the images without ghosting removal. People are always on 

the move in a busy train station! Without correction, ghosting al-

ways occurs with multiples exposures 
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The detailed process illustrates a special procedure. It attempts to predict 

movement within the bracketing in order to remove the ghosting more 

accurately. New in version 4 are the intelligent settings for life forms, 

landscape, architecture and sports. The “Life forms” corrector is perfect 

here. 
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9. Post-Processing: Presets 

Just like in the last version of HDR projects professional we shall start 

after the uploading of images directly in post-processing. Here we control 

the tone mapping of the images, before editing the results with filters and 

effects.   

Left side of the post-processing screen: 

Before you begin testing the different Presets 

when continuing to edit your photos, remember 

you also have the HDR Style option at your 

disposal. Here you can choose between options 

such as “Balanced”, “Shade and Light”, Fine 

Details”, “Grunge”, and “Vibrancy”.  

The presets show the breakdown of the live 

preview in categories - “All”, “Natural”, “Land-

scape”, “Monochrome”, “Colour fidelity”, “Cus-

tom”, “Surreal”, “Architecture”, “Artistic”, and 

"Glow" with the quantity of presets in the appro-

priate category.    

To begin, we’ve chosen the “Natural balanced” 

preset. Clicking on the preview image applies 

the effect to the image in real time, which will 

then be displayed in the middle of the screen.  
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Discover the wide variety of different looks by clicking on the 155 different 

presets. You will be amazed by the intriguing styles in the artistic section!   

 
Image with “Natural balanced” preset 

 
Image after applying the “Landscape Colour and Detail” preset.   
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All 155 HDR projects 2018 professional presets at a single glance. The 

bar “pre-settings” you can detach easily and adjust to the desired size. 

 

 

 Preview Gallery    

Would you like to see all the previews for the loaded image or series? 

Open up the category “all” and then subsequently click on the symbol. 

 

HDR projects 2018 professional constructs then a browser gallery with 

all the presets. For a larger display click on the picture. 

 
 

This very practical feature is reminiscent of good old contact sheets. You 

can create proofs to assess how the image with your favourite presets 

would look when printed. 
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  The variation browser 

 

The variation browser allows you to choose from different versions of a 

function and is primarily operated with the mouse: 

 Shifting the segment: hold down the left mouse button, 

before moving the mouse 

 Zooming in: scroll up 

 Zooming out: scroll down 

 Choosing the variant: double left click on the image 

 Setting a referent: left click on the image 

 Comparison with referent: hold down the right mouse 

button over the image 

 

The corresponding short cuts you can find under “information -> short 

cuts”. 

 
 

Click on the symbol and HDR projects 2018 professional will show you 

the entire preview gallery of that chosen category. Zoom in now on the 

variant that you want to compare and set a reference image. 
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This reference image you will be able to put on any image through a left 

click of the mouse. You can fade in this reference image into the other 

image by holding down the right mouse button.  

The border surrounding the image in a green dashed line shows you the 

reference image so that you can make the comparison. In this way you 

can compare any two variants in the browser directly and visually. 

Example: As a reference image you choose the variant “landscape bril-

liant” and mark the image with a left mouse click. The green dashed line 

shows that you have chosen this image. 

 

 
 

Now you look for a different preview image, in this case Preset landscape 

bicolor 1 has been chosen. 
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Right click on the preset landscape bicolor 1 and the reference preset 

will fade in. As soon as you let go of the mouse button, you will see the 

Bicolor 1 Preset again. This is how you simply and purposefully compare 

looks with another before choosing the ones you like the best.  

 

Selection of your desired variation: 

With a double click you chose the variant. The relevant program settings 

will be carried out automatically. 

 

Tip:  

Your current choice will, when you open the window, be automatically set 

as your reference image. 
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 Combine Presets    

To merge two looks together use the “Combine default presets" button 

directly under the categories. These new presets will be saved under 

"Custom". It’s that easy to expand your numerous options and accumu-

late new ideas! 

 

 Name Favourites    

Have you found 

certain presets that you love and instantly want to have handy? Click on 

the top right star in the preset window and add the setting to your fa-

vourites. By clicking the button, previews all of your favourite presets will 

be displayed. 
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 Save Undo-Point  

With the Save Undo-Point Function you can save your edits to an 

image at different intervals and later view these in the Timeline and 

pick up where you left off.  

 

Timeline  

In the Timeline you can view and directly access all saved Undo-

Points. 

  

 Image Sequence View   

Image Sequence View lets you view all sequences of your image or 

series at a glance.  

 

 

 Panoramic View  

Panoramic View enables you to take an even closer look at your im-

age by displaying it as a panorama image. 
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 Comparison View 

 

 

 

 

 

 

 

 

 

 

 

 

 

Do you want a comparison to the HDR image without tone mapping? 

Simply right click on the middle of the image to see the before/after result.  

A quick check on the editing process is available at any time. For an 

extensive overview with selectable areas and luminance display, click on 

the symbol bar. 

 

 Histogram  

The Histogram shows the distribution 

of tonal values within your image.   
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 Real Time Processing 

 

When activated, all of the changes that you have made to the preset 

settings will be immediately applied to the image and you will see the 

outcome of your adjustments directly. If this option is deactivated, then 

you will only see the outcome of your adjustments when you click the 

button “calculate afresh”:  

 

 

 High-Quality Display 

 

Activate this option to see the preview image in high-resolution. If the 

preview is set at 100%, there will be no difference. If you zoom in on a 

section of the photo however, there is a noticeable difference in quality.    
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 Border Pixel Display 

 

The border pixel display helps to reveal areas that tend towards maximal 

light and dark values that is to white and black. Dark border pixels are 

depicted by blue and light pixels by orange.  

 
Depiction of border pixels in dark blue and orange tones.   

If you would want to brighten this image, you have to be careful of the 

orange border pixels. Light surfaces on the car and the walls should not 

become too white, in order to avoid losing detail. In technical terms, these 

patches are called “burned highlights”. The border pixel view helps to find 

these critical image areas 

 

 Symbol „ original resolution setting “ 

 

With this pushbutton you will set the zoom factor on the original resolu-

tion. 



HDR projects 2018 professional – User manual 

 

45 

  „Increase the Zoom factor to screen size“  

With this symbol you will enlarge the zoom factor to the maximum possi-

ble screen size. 

 

 Import/Export from Presets  

 

Presets from earlier versions can be easily imported. Do you want to 

exchange all of your presets with a friend or just secure all of your treas-

ures? Use the practical export function. 

 

 Filter Presets 

Locating presets can be difficult when you have imported presets or 

created many additional looks. For example, enter “filter" into the search 

bar and only presets relating to “filter” will be shown, for example “red 

filter”, “gradient filter” or “polarising filter”. This makes the search a lot 

easier. 
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10.  Post-Processing: Finalisation 

Now that we have understood the most important part of post-

processing, let’s go onto fine-tuning, which can be found on the right side 

of the screen under “Finalise". 

These features are intended to 

only to be used to edit pictures 

further after selecting a preset. 

 

 

 The magnifying glass  

On the right hand side (at the very top) in Post-processing you will find 

the 1:1 magnifying glass. The magnifying glass shows you the area under 

the mouse in a 1:1 pixel view. 
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When clicking on the magnifying glass the new compare window will 

appear, which compares your edited image and the original image. It 

simultaneously gives you the opportunity to examine the comparison 

through the magnifier display. 

 

To keep the magnifying glass on a specific point, press down on the “L“ 

key, while you move the mouse over the screen. 

          

Click into the image area of the magnifying glass, to change between the 

display modus “divided before/after comparison” and “direct before/after 

comparison”. 
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To free the fixated area of the magnifying glass, press down on the “L” 

key once more. 

 Point of Interest    

Activated “Point of Interest” renders the current editing only to a specially 

defined area of the image. The effects will be applied in their full form, 

however only visible in the specified spots, the rest of the image will be 

left unaffected. This effect is intended for very large, high-resolution pho-

tos, for example panorama pictures.    

 HDR/Ultra HDR   

This technology describes the art of fusion of bracketing series images. 

Ultra HDR processes up to 30 intermediate images between two photos 

with 64-bit precision. The result speaks for itself, and clearly shows a 

more detailed picture, especially in difficult situations, for example when 

shooting directly against the light.  

 
 

 

 

 

 

 

 

The strength of Ultra HDR can be seen in sensitive situations: the 

sunlight in the image on the right is significantly more detailed and 

less overexposed.   
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This highly precise calculation system can be applied to specific types of 

motives: daylight, landscape, twilight, architecture, interior, night-time 

and mixed light. 

These settings can be accessed in post-processing at any time. 

  

 Scenario   

Additionally, the HDR fusions can be influenced by different scenarios. If 

you would like to adjust your result to a certain lighting, select one of the 

following seven scenarios: “Daylight”, “Landscape”, “Twilight”, “Architec-

ture”, “Interior”, “Night-time" and “Mixed Light”. The scenario option has 

an overview of all of the possibilities that can be directly applied with just 

one click.   

 

 HDR-Algorithms 

Here a mathematical equation is used to determine the weighting of each 

individual exposure in a series - pixel for pixel. Every algorithm has a 

different effect depending on the bracketing and subject. There is no right 

or wrong here, rather your originality is in command. Test your bracketing 

series with different algorithms and see how they affect your photos. Tip: 

The HDR algorithm “Entropy”, in most cases, will yield a finely tuned and 

detailed result in all tone values.    
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 Intelligent Colour Space (SCA Method) 

 

This menu offers you options for optimal colour detail gradation of your 

tone mapping results. Selecting SCA method (Smart Colourspace Adap-

tation) demonstrates differences in the details of more saturated colours.   

Tip: With “Supersampling” you will get exceptional details and saturated 

colours and stark color variations around contrast edges.  

 

  Optimisation assistent 

The optimisation assistant is a very 

efficient tool for fast, fascinating results. 

When the preset is activated, 

denoising, tonal value, clarity, 

dynamic and sharpness settings can 

all be adjusted by sliding the control to 

the left or right. The result can be seen 

live. 

The optimisation assistant is intelligent; 

it remembers the values you entered, 

and applies the same settings to the 

next image in the same way, but tuning 

the result to the new motif.  
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If you would like to edit without the assistant, you can simply turn it off. If 

you would like to turn off the values that have been “learned” so far, click 

on the    

Additionally, the assistant can be 

given optimising specifications for an 

entire image style: choose between 

„naturally cool“, „naturally warm“, 

„soft“, „fine“ „brillant“, „intense“, „mut-

ed colors“, „Multicolor“, „High-Key“ , 

„Low-Key“ und „Low-Key Multicolor“. 

 

 

 The opacity regulator of the optimisation assistant 

The opacity regulator in 

the optimisation assistant 

activates itself automati-

cally as soon as one opti-

misation is activated. The 

opacity regulator works on 

every effect that optimises 

the image as well as the 

optimising presettings. 
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Tip: 

Put the optimisation presetting in “High-Key” and chose an opacity regu-

lator between 40-60%. 

Pro Tip: Remember that the preset specifications and Optimisation As-

sistant are added together. If you select the “Surreal powerful colours" 

preset and the “Intense” optimisation, you will get strong, saturated col-

ours and dramatic contrast. Not to worry, you can quickly change back to 

the “Natural” optimisation and have the familiar look of the “Surreal pow-

erful colours" again. On the other hand, you can compile new creative 

ideas and jump between intense, unsaturated and high and low key looks 

lightning fast. 

 

 Granulation module 
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a) Natural grain 

In natural grain the different levels of photographic paper are simulated, 

which creates a natural irregularity. 

These following parameters are therefore at your disposal: 

- Form  

Choose here from six different variants. 

 

- ISO-Number 

The preset value conforms to the average “restless value” on a naturally 

grey surface. 

 

- Size 

Die maximale Größe des simulierten Korns. 

 

- Masking 

Gives you the opportunity to calculate the granulation in all different types 

of daylight or alternatively in light, shade or shade and light. 
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Here the Masking has only been set for the lights. This way they 

receive a natural granulation, while at the same time the 

sky is spared. 

A Click on the button creates a new random distribution of grain and 

therefore a whole new look. 

 

b) Fractal grain 

Fractal grain simulates a large scale irregularity, which is created through 

the storing and deterioration 

of photo material. Therefor 

the following parameters are 

at your disposal: 

 

 

- ISO-Number 

The preset value conforms to the average “restless value” of a naturally 

grey surface. 

 

- Quality 

Determines the accuracy of the calculation (number of iterations for the 

fractal algorithm) of the fractal granulation. 

In the granulation module there is no singular best setting, since the ideal 

grain size, form and quality is 100% dependant on the motif. Here you 

can try out different things and find new creative paths. 

 

 

A Click on the button creates a new random distribution of grain 
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and therefore a whole new look. 

 

 Information and helpful tips on making local adjustments and us-

ing Selective Painting can be found in Chapter 12. Local Ad-

justments/Selective Painting.  
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 Removal of Scratch and Sensor Errors 

 

 

Micro-contrast enhancement used in HDR photography unfortunately 

shows every unwanted sensor imperfection that every photographer, 

despite internal camera sensor cleaning, knows and dreads. Don’t stress 

- just eliminate them! With the easy to apply correction function from HDR 

projects 2018 professional, it can even be fun.   

Pro Tip: This intelligent correction doesn’t only remove sensor spots, but 

other disturbing things too - a deserted beach has never been so easy to 

produce.   

Simply mark defects in your motif, the program will automatically substi-

tute these areas with other appropriate parts of the image.  

 

The sensor spots are circled in red 



HDR projects 2018 professional – User manual 

 

57 

Here’s how to go about correcting: 

Select the brush tool under (6) and click on the point of the image that 

you would like to correct. A circle will appear beside it that will serve as a 

source.   

Move this circle to a place on the 

image that can act as a source 

for the first marking. The select-

ed area will then be improved 

based on the source.  

 

Prior to this, you can reveal 

sensor spots, which will appear 

as a bright patch in the image, 

with (1).  

 

(2) Allows you to expose or hide 

the fixed areas. The corrections 

are still active, even if they have been blended in.  Hiding is solely to 

enable a before and after comparison.  

You can select multiple areas to correct by simply clicking on the brush 

symbol (6) and adding another point.   

 

The button marked (3) can blend the targeted corrections in and out, 

which also controls clarity.  

 

(5) Deletes the added corrections.   

 

The section marked (7) controls the size of the area that is to be correct-

ed.   

 

You also have the option to automatically search for the best source area 

for the improvement. Click on the (8) button.   
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Button (4) calculates the appropriate correction spots for all of the points 

automatically set using (8).   

All currently selected corrections can be deleted with the (9) button.   

 

 

 
 

The sensor spot corrector marks all of the patches and determines a 

source within the image that can be used as a substitute. 

 

 



HDR projects 2018 professional – User manual 

 

59 

 

Successful sensor spot correction. 
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  Post-Processing Expert Mode 

 

The Post-Processing expert mode 

can be found on the right side of the 

screen. Here you can configure all 

postprocessing, try new effects, 

adjust a selected preset or construct 

a completely new preset to meet 

your desires. 

Overview of the Tools: 

a) Tone Mapping Algorithms  

b) Post-Processing Effects 

c) Selected Tone Mapping 

and Effects  

d) Settings for Selected 

Effects 

 

 a) Types of Tone Map-

ping (13) 

Tone mapping algorithms compro-

mise the dynamic range of images 

with strong contrast down to a pre-

sentable range and serve to im-

prove the quality of the image.  
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HDR projects 2018 professional offers 11 different algorithm options 

that can be applied individually or combined.   

Simply double click on the entry to add the tone mapping to your selected 

filter.    

 

All tone mapping works by compressing the local tone values and con-

tains an integrated detail enhancer for macro and micro details. 

 

Tone Mapping Contrast: 

Contrast Tone Mapping creates well defined shadows and lights and is 

suitable for landscape and architecture photographs. 

 

Tone Mapping Brilliance: 

Brilliance Tone Mapping creates a soft luminosity in the shot and is suita-

ble for broad palettes in motifs. 

 

Tone Mapping Colour Fidelity:   

The newly developed colour fidelity processing works with maximum 

precision for colours in tone compression and is exceptionally suited to 

shots with intense colours.    

 

Tone Mapping Gradient:  

The tone mapping gradient algorithm has a substantial effect and is well 

suited to subjects with weak colours and high contrast.    

 

Tone Mapping Gradient Luminance:  

This process is a modified version of the gradient process, and especially 

enhances lighter areas. 

 

Tone Mapping Contrast Gradient:  

This option yields best results for subjects with mainly middle colours. 

 

Tone Mapping Middle Values:  
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Tone mapping middle values is a very stable process and suitable for 

almost every subject.      

Tone Mapping Middle Value Exponents:  

This effect is stable and works best for dark areas. It is especially well 

suited to tunnel and archway shots.    

Tone Mapping Middle Value Gradient:  

This process was specially optimised for dark bracketing. Dark areas will 

be significantly lightened even with slight intensity (tone compression).   

  

Tone Mapping Quotient:  

This is a general tone mapping process that neutralises a colour saturat-

ed image, when compared to the effect of a gradient process.    

 

Tone Mapping Sigmoid:  

The sigmoid function is specialised for scaling brightness of motives with 

drastic highlights.  

   

Tone Mapping Surreal:  

A very intense feature and therefore a good basis for extreme HDR im-

ages.    

 

Tone Mapping Intense:  

Intense tone mapping works with a high bandwidth of tone compression 

and therefore can be very effective for both dark and light bracketing 

series.    

 



HDR projects 2018 professional – User manual 

 

63 

 Post-Processing Effects (121)  

The list includes 97 different post-processing effects that can be freely 

applied and combined.   

The effects are divided into seven cate-

gories, each with a corresponding back-

ground colour.   

Black: masking effekts 

Yellow: border effects  

Green: geometric effects  

Turquoise: exposure effects  

Blue: colour effects  

Purple: diffusing effects  

Pink: artistic effects   

 

Tip: If you are looking for a certain effect 

and know its name or part thereof, you 

can save time by using the search bar. 

 

When you are applying new post-

processing effects, check to see if the 

optimising assistant is active. If it is, 

please remember that effects will act 

differently, and sometimes more ex-

treme. When constructing or enhancing 

a preset, it is best to turn it off. (Button 

above the tone mapping). 
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Overview of Post-Processing effects in HDR projects 2018 professional 

 

12 new Post-Processing effects 

Chromatic Correction Chromatic Shift  

Dilatation Erosion 

Color Channel Mix  Intense Light  

Offset Normalize 

Normalize (RGB) Pop-Art 

RGB Transformation Center Exposure 

 

 c) Select Effects 

Have you found an effect that you 

would like to try out? Simply double 

click on it in the post-processing effect 

list.   
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The effect will now be shown in the block below called “Effects you have 

selected".   

The block of selected effects is the heart of the tone mapping and post-

processing area. It includes all of the post-processing effects and the 

settings for each individual effect.   

The filters in the example are automatically applied one after the other to 

the HDR image and lead to the result tone mapping image.    

To temporarily deactivate an effect, simply click on the box beside the 

effect’s name and remove the checkmark.   

Double clicking on an effect removes it from the list.   

Effects can be sorted at will by dragging and dropping them up or down 

the list.   

One click on Result to Original will copy your image result into the pro-

gram as its own original image. This allows for the creation of an export 

within the program itself.  

Tip: The order of the effects within the list can 

have a substantial effect on the resulting image. 

It’s worth playing with!  

Activate the 360° panorama mode in the bottom 

left box to prepare your images for a perfect 

panorama stitching. The images will be opti-

mised, so that no borders can be seen when the 

panorama is assembled.  

The context menu for the effects you have se-

lected has numerous functions that allow you to 

activate, deactivate, move or duplicated effects.   
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 d) Settings for selected Effects 

Settings for the selected effects can be found directly below the block for 

the effects you have selected. The parameters for the currently select-

ed effects will always be shown here.   

The available settings and options change de-

pending on the effect you click on. There are slid-

ers, gradation and mask curves, colours and pi-

pettes etc. Alternatively, a numerical value can be 

entered into the box above the slider. 

In the example, we see the parameters for “Colour 

Balance”, which consists of three controls for 

balance: cyan-red, magenta-green and yellow-

blue. Sliding the controls instantly adjusts the 

image. The adjustments will be immediately por-

trayed in the result image. You will also see a colour flow within the con-

trols, which will give you a direct indication of how the new value will 

affect the photo. 

 

 

Adjusting the cyan-red and yellow-blue values creates a signifi-

cantly warmer feeling for the image.    
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 Example Mask Curves  

This curve regulates the intensity of the 

effect for particular bright areas of the 

image.  When you pull a point down-

wards, pixels with this brightness will be 

impacted less by this specific effect, 

and vice versa.    

Here as well you will find on the top right 

hand side a choice box with presettings. 

For example the setting “bright lights” 

has been chosen. 

For the gradation curve in this example, 

it means that the lights in the picture will 

be brightened, and the dark roots will 

exempted in order to create a striking contrast. This is how 

mask curves give you the opportunity to selectively influ-

ence images.   

During the editing, the preview behind the mask curve 

immediately shows the effect’s intensity from black (no 

effect) to white (full effect).    

 Layer Processing Methods  

These features determine the way that an applied effect 

appears on a layer. Effects can thus be enhanced or re-

duced, and looks can even be completely changed, which 

opens up a plethora of opportunities to play with. To apply 

processing methods, click on the drop down menu begin-

ning with “Normal”.   
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So that you don’t have to try out every single effect, we have a layer 

mode browser:   

 

With just one click, you have an overview of all of the processing meth-

ods and can comfortably choose which method fits the effect best. Give it 

a try! The effects that you can generate with layer processing methods 

are astounding!   

 Selective Editing    

For every single one of the 81 post-processing effects it is possible to 

apply the selected effect to only a certain area.   

Furthermore, specified areas of an image can be influenced at different 

intensities by different effects.  

The selective editing can be controlled in the parameter area of each 

effect and you can open the accompanying window with the button at the 

far left.   

At the bottom of this window there are three blocks with six, three and two 

buttons.    
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The example clearly shows that the „Color Luminosity“ effect has only 

been applied to the selected section. Since the edge definition is only set 

to 95%, this area is almost rectangular. 

6 Block: add, remove, duplicate, flip and delete the selected areas  

3 Block: various display modes for the resulting intensity of the effect  

2 Block: choice of selected surfaces, very practical if the specified areas 

are very small or overlapping  

You can add up to 32 amplifying (positive) or reducing (negative) areas 

for the current effect. The size and position can be determined directly in 

the image, optionally in the corners or on the sides of the area.    

The roundness of the rectangle as well as the sharpness and severity of 

the selected area can be adjusted with the three controls at the top of the 

window.   

The result will always be instantly displayed upon releasing the mouse 

button. 
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 Selective Editing – gradienten module  

You can choose from every post-processing effect in the area of selective 

editing a course (gradient) of 56 premade models with a single click. 

To activate the desired post-processing effect from your chosen effects, 

click in the underlying parameter area on the gradient- slider. 

 

A window will open with different types of gradients. From there choose 

with a left click your desired type of gradient. 

 

Tip:  

When you choose a gradient model the selected areas (that are possibly 

already part of the current chosen effect present) will be copied into the 

clipboard. The selected areas can be brought back via the insertion of the 

slider. 

 

 

 Overview of Certain Keyboard Shortcuts 



HDR projects 2018 professional – User manual 

 

71 

Cursor Buttons: move the current, active, selected area  

Ctrl/Alt + Cursor: fast movement of the current, active, selected area  

1,2,3: switch the display mode  

Delete: deletes the current, active, selected area  

Esc: closes the window  

Upon closing the window, the chosen effect will only be applied to the 

selected area and displayed in the middle of the screen.   

You can transfer other effects to the selected area with the “Copy” and 

“Paste” buttons , without having to retrace the selection again. 

 

 

This button deletes all selected areas of the active filter, of course 

with a confirmation prompt first. 
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 Custom Presets 

One thing is certain, regardless of which settings you have changed, if 

you have applied additional filters or adjusted a filter’s settings, the se-

lected preset has been modified and to the right of the preview image is 

the following symbol:   

Clicking will reset the preset back to 

its initial state. Careful: All of the modifi-

cations applied up to this point will be 

undone!  

Clicking   saves all of the changes in 

a new preset.  

A dialog box will open where you can enter a new name for your preset or 

confirm the suggested one. The system will name it “Copy”.    

 

 

The preset will be saved and moved to the “Custom" presets category. 

The new preset has been additionally generated and the starting preset 

is preserved. You can also never overwrite a default preset!  

Let’s switch now to the “Custom" preset category.   

Here we can find our first custom preset.   

There are a few new symbols to the right of the preview image: 
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  Is this the favourite preset that you 

have made? Mark it to find it right away 

next time!   

 

 Have you changed this preset and 

don’t want to lose this new look? Then 

create a new one!   

 

 Reset the most recently changed 

settings for the newest preset 

 

 You have readjusted once again? No 

problem. Save the changes with the disk 

symbol 

 

  Change the preset’s name 

 

  You can also delete your custom preset entirely.   

 

 

 Use this to enter a search filter. For ex-

ample, enter the search filter „Color play“,  and 

subsequently type the term into the search 

filter bar directly under “Import". All presets 

with this search filter will be displayed. 
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You can enter the names of places you’ve holidayed and all of the pre-

sets that you used for those specific holiday photos will then be easy to 

find and to apply to other pictures.  

The filter drop down menu to the right already contains „Color play“ and 

you can simply select it from the entered search filters. 
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11.  HDR Generation and Bracketing Editing 

What happens in actual HDR image generation in HDR projects 2018 

professional, before post-processing has made the image printable and 

suitable for display on monitors?   

In a bracketing series, every individual image area contains a various 

number of pixels that are either under or over exposed. Let’s assume that 

every section of the photo is correctly exposed in at least one of the 

images in the series.   

HDR projects 2018 professional uses a complex process to correctly 

filter out all of the accurately lit pixels and assemble them into one com-

plete image. The process is determined by mathematical commands - 

the algorithms. Various algorithms influence different HDR results, which 

depend on the final brightness of the series of images.   

The software professionally takes over this process for us. We simply 

have to attend to the result and decide which outcome is most visually 

pleasing to us and which HDR image we would like to edit further.    

 

 HDR-Weighting 

From post-processing in HDR projects 2018 professional, transfer to 

HDR generation with this button. We see the work area on the left hand 

side for HDR weighting, and HDR algorithms on the right. Your HDR 

picture will always be displayed in the middle of the screen while editing. 

At the moment the image doesn’t look all that spectacular, but remember 

that the monitor cannot yet properly show what was actually calculated.    
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a. The checkbox at the top left allows you to 

exclude or activate an image from the se-

ries for the HDR processing. If you re-

move a bright picture from the series, the 

HDR image will be darker in the midtones in certain areas and 

vice versa.    

 

b. Directly below is the miniature 

view of the single bracketing 

exposure. Left click to display 

the image at full size. Another 

left click on the mini-picture 

will return the HDR final im-

age. 

c. To the right of the colour view is the HDR weighting matrix for 

the particular image of the series.  
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d. Bright pixels indicate that this area will have a significant influ-

ence on the resulting HDR image. Dark pixels indicate that this 

shot will have little influence on the final HDR photo 

e. The minus button  under the weighting colour removes an 

image from the loaded 

bracketing series. It is on-

ly possible to delete ex-

posures that are above or 

below the master image. 

The master image itself 

cannot be removed and 

has no minus symbol.    

 

f. The button to the left under the bracketing preview im-

age selects a new master image. You will clearly see a 

significant difference in the brightness distribution of the HDR 

fusion. 

 

 Synthetic Bracketing 

With help from this exceptional technique, gaps in bracketing series can 

be filled.   

Let’s suppose, and this is no individual case, that the longest exposure of 

a series came out somewhat blurry. Click to remove the image from the 

series and let the system generate a synthetic bright image for you. All of 

the shots in the series are already sharp.   

This technique can also be used for manufacturing an HDR image out of 

a single picture. Two synthetic exposures will be generated for an up-
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loaded single image, one with reduced exposure time and one with in-

creased exposure time.  

 

 

An additional image will be synthesised when only two bracketing images 

are uploaded so that there are always at least three photos available in a 

bracketing series  

 

Click on                                                                       and add another synthetic im-

age to the series. The original image will always be used as the master 

image. New images will be labelled as “Synthetic”.    

 

 

 

 

 

 

 

 

 

 Global weight & Exposure value (EV) 

For every exposure in bracketing series, synthetic or real, there are two 

controls that are very influential on the HDR process:  

• Global weight  

• Exposure value (EV) 
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The example shows the master image directly after being loaded. The 

weighting and exposure controls are in the middle. The window to the 

right of the preview shows how the image is represented in the HDR 

fusion. Sliding the global weight to the right, raising it, increases the pro-

portion of this image in the final HDR fusion. This can also be recognised 

through a brighter weighting matrix. Here “Bright” does not mean that the 

image will become brighter, rather that the shot will compose a greater 

portion of the HDR fusion. The result can become brighter or darker.   

The picture will become brighter once you adjust the exposure control 

underneath towards “Bright”. This adjustment can be applied to each 

image in the bracketing series and therefore have a substantial impact on 

the HDR fusion.   

Simply try it out! If need be you can set the controls any time back to its 

original setting. 

 

 Global Weights 

Above the actual bracketing series are the presets for global weight 

called HDR weight default settings.   

You can choose an automatic setting for global weight from seven algo-

rithms with these presets:    
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Equal: all of the weight will be set to the middle position, and every expo-

sure of the bracketing will be equally represented   

Luminance: sets all global weight to an average brightness (luminance) 

that corresponds to each respective image in the series  

Congruence: sets all global weight to a value corresponding to the aver-

age amount the bracketing images cover the master image  

Luminance/congruence: sets all global weight to a value corresponding 

to the average brightness in relationship to the average coverage by the 

bracketing images  

Master dominant: generates an HDR fusion where greater significance 

is attributed to the master image  

Luminance dominant: all brighter images from the bracketing series are 

more significant in the HDR fusion  

Shadow dominant: all darker images are weighted more than brighter 

ones 

Pro Tip: Choosing a congruence setting can, for some bracketing, lead 

to less ghost images. 
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 Right side „editing bracketing se-

ries“ 

 

a) HDR-fusion profile 

HDR fusion profile is the ideal opportunity to 

save the settings of HDR-fusion on a bracketing 

series for later use. 

 

 

 

Following functions of the HDR fusion profile are 

at your disposal: 

 Choice of a profile from the list by click-

ing on it 

 

 Saving the current settings as profile 

 

 Deleting the current profile 

 

 Import/Export of profiles 
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Which settings are saved in a HDR fusion profile? 

Generally in a profile all the data of HDR fusion setting are saved: 

 The settings of all the HDR-algorithms 

 The automatic motif brilliance 

 The ghosting correction setting 

 The contrast edge definition optimisation 

 

b) HDR/Ultra HDR   

New Ultra HDR technology for fusing bracketing series: Ultra HDR pro-

cesses up to 30 intermediate images between two photos with 64-bit 

precision.  

The result speaks for itself, and clearly shows a more detailed picture, 

especially in difficult situations, for example when shooting directly 

against the light. See chapter 9 “Post-processing: Finalisation” for 

examples. These settings can be accessed in post-processing at any 

time. 

Scenario   

HDR fusions can also be influenced by different scenarios. If you would 

like to adjust your result to a certain lighting, select one of the following 

seven scenarios: “Daylight”, “Landscape”, “Twilight", “Architecture”, “Inte-

rior”, “Night-time" and “Mixed light”. The scenario option has an overview 

of all of the possibilities that can be directly applied with just one click.   
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c) HDR-Algorithms 

The HDR algorithms can be found together with the setting controls at the 

right side of the user interface. 

HDR algorithms are mathematical procedures that determine the weight 

of individual images from a bracketing series pixel for pixel. (See HDR 

Weight). Every algorithm affects the final HDR result differently and, 

depending on the motif, more or less intensely. 

 

Overview of HDR Algorithms  

HDR projects 2018 professional offers 13 different HDR algorithms to 

choose from. Click on the algorithm browser for a quick overview. Here 

you can choose your preferred settings.    

Average: The average is the easiest form of HDR generation and uses 

the bracketing midtones.    

Entropy: In information theory, entropy is a measure of the density of 

information. When applied to an HDR fusion, the appropriate algorithm 

measures the density of information of each of the bracketing images 

pixel for pixel and converts this weight into the HDR generation. The 

result is a very stable process that is set as a standard algorithm for HDR 

projects 2018.    

Luminance Distance: Luminance distance applies the average bright-

ness distance in the image as the weighting for the HDR fusion. This 

algorithm is also a universally applicable process that can be used for 

almost every bracketing series.    

Colourmix: The colour mix process applies the colour proportions of the 

pixels as a weighting measurement. It is particularly suitable for bracket-

ing series with limited brightness differences in certain areas, for example 

fog, smoke or cloud shots.    
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Luminance Entropy: The luminance entropy is a combination of the 

Luminance Distance and Entropy processes.    

Luminance RGB: The RGB process combines the Luminance Dis-

tance and Colourmix processes into a new procedure which is best 

suited to landscape shots 

Linear Luminance: The linear luminance applies the luminance as the 

weighting for the pixels.    

Logarithmical Luminance: This algorithm works with logarithmic 

brightness (luminance). This corresponds to the human eye’s perception 

of brightness, which makes this algorithm appropriate for most bracketing 

series.    

Quadratic Luminance: This algorithm works with the fourth power of 

brightness and is thus well suited to editing bright bracketing series.    

Chroma: This algorithm calculates the weighting from the colours of the 

individual images and is best suited to bracketing series with high colour 

contrast.    

Absolute Distance: A very powerful HDR fusion technique, which com-

bines two essential features. When HDR Smoothing is deactivated, all 

HDR images are free of halos and brightness outlines are avoided.    

Luminance Sharpness: For this algorithm, the luminance sharpness 

(brightness) is determined for each pixel and converted into a weighting. 

This process yields the best detail for HDR fusions.    

Colour Sharpness: The colour sharpness process, like the luminance 

sharpness feature, determines the sharpness, that is, the level of detail, 

for every pixel. This technique uses each colour channel, and is thus best 

suited for bracketing series with intense colours. 
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Repro neutral: This HDR-process is specially optimised for bracketing 

series of scanned photo data with a normal light situations. 

 

 

Repro intensive: The Repro intensive HDR-process is built for scanned 

images with low quality. For example images from old Dia-scans. The 

fusion of images is here clearly carried out even more intensive. 

 

Which algorithm should I choose? If you are not sure which algorithm 

would be best suited to your subject, use the “Absolute Distance”. This 

one is always a good choice.  

Otherwise, you can always access and adjust the HDR algorithms and 

post-processing/tone mapping at any time.     

 

d) HDR Smoothing for Selected Algorithms: 

Just below the selection list for 

HDR algorithms is a block with 

controls for fine-tuning colour 

sharpness: “Chroma HDR 

smoothing" from sharp to very 

soft. 
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Further parameters for the adjustments of HDR algorithms: 

Denoising: Denoising appears directly 

on the HDR image and the noise re-

moval intensity is also presented as a 

percent. A value of 0% means that no 

noise pixel will be removed, and a high-

er value removes more noise from the 

HDR image, which would be favoured 

for sharpening an image.   

HDR Smoothing: HDR smoothing 

directly influences the weighting matrix-

es that were created by the HDR algo-

rithms. The smoothing intensity is dis-

played as a percentage, indicating how 

dependent the result is on the image 

resolution. A value of 50% means that 

weighting matrixes will be smoothed by 

50% of the image resolution. The 

smoothing works with the Gauß´schen scrim diffuser.  

Night/Daytime: The day and night controls match the HDR algorithms to 

day or night shots. Move the control to the left for night, when your brack-

eting series is suited to a night image, and to the right for day, when your 

bracketing series is suited to a photo taken during the day. You can also 

just as easily switch the setting to quickly change the picture’s mood.   

For some HDR algorithms there is an additional feature available, in this 

example the “Luminance Distance”. 
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Halo Adjustment: The halo adjust-

ment deals with a typical HDR gen-

eration problem: the formation of 

halo effect (HDR shadows). The 

image on the left has a minor defect, 

there are halos where the roof meets 

the sky. 

 

 

In the right-hand image, the halos were reduced by 85%, so that the halo 

effect around the roof has disappeared. 

 

 

 

 

 

 

The halo control is available for certain HDR algorithms, here the “Lumi-

nance Entropy” algorithm was used. 

 

 

e) Subject-briliance: Activate the automatic intelligent optimisa-

tion by clicking on the box. 
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f) Ghosting correction 

(Interactive, automatic optimisation of ghosting correction) 

 

In the area of ghosting correc-

tion the automatic optimisation 

will start through clicking on the 

“automatic optimisation” button.  

Directly on screen you will be to 

see the optimisation process. 

Here different parameters for 

the detail prognosis as well as for the intensity are tested by the program 

until the best combination is found. This combination will then be inserted 

into the program for you. 

This calculation can take several seconds, depending on the size of your 

bracketing series. 
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In the result you will get a HDR-image without ghosting and which 

through automatic optimisation now includes the maximum possible 

amount of details. 

 

Tip:  

When you adjust the focus of the ghosting correction, you will be able to 

start the automatic optimisation anew and to receive a new result that is 

optimal for the new focus. 
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g) Contrast range 

(HDR-contrast range and automatic optimisation) 

The contrast range of a HDR image is made up of the division between 

the brightest area of a photo for example a photo directly in the sun and 

the darkest area so in the shade areas of the image. 

 

A calculation example: 

The brightest area of an image 

has a value of 5 (the value 1 

would mean a white pixel in the 

image) and the darkest area in 

the HDR image has a value of 

0.01. 

 

 

If one divides now 5 by 0.01 then 

the resulting contrast rage of 

5/0.01 = 500. This means that the proportion between the brightest to the 

darkest area of the image is 500 to 1.  

From this contrast range you can take inspiration from the area “contrast 

range”. 
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The compression value shows how strong the compression of the HDR 

image brightness is in comparison to a non-manipulated HDR image. 

Here it is 0%, since we haven’t done any changes yet. 

The compression value you can adjust as you wish to. A low value cre-

ates a higher contrast range in the HDR image (the HDR is being 

“stretched” in its brightness). A higher value creates a smaller contrast 

range (the HDR is being “compressed” in its brightness). 

Underneath the controller you will find three buttons, which control the 

automatic optimisation of the contrast range: 

 High-contrast: Creates a high-contrast HDR image. Therefore 

an image with very deep shadows and very bright lights. 

 Optimal: Creates a well-balanced HDR image. 
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 Compressed: Creates a HDR image with a small contrast 

range. This can be helpful with contrast rich bracketing series, 

since it helps to bring out further details in tone mapping. 

As soon as you confirm the automatic modus you will be able to follow 

live, how the best values for your current HDR image is searched for. 

Tip:  

This value is for every HDR algorithm different. So it could be a good idea 

after the change of a HDR algorithm to click on the desired automatic. 

Under the automatic optimisation buttons you will find a curve display. 

This shows how much the brightness values of the HDR image have 

been adapted in the contrast range optimisation of the program. 

 

Curve display of the distribution of the brightness value: 

     
High-contrast     Optimal          Compressed 
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In the above example we see how the same HDR image with the optimi-

sation “high-contrast“ (above image) and the other with the optimisation 

“compressed” (bottom image) are handled. 
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12.  Local Adjustments and Selective Drawing 

 

 

The selective highlight tool from HDR projects 2018 professional de-

serves very special attention. Firstly, this tool selectively edits chosen 

areas without complicated masks done by hand, like other photo editing 

programs. HDR projects 2018 professional includes a completely 

newly developed intelligent border recognition algorithm that inde-

pendently identifies borders, lines, 

differentiations and light differences in 

drawing mode. The boundaries of the 

area that the mouse skimmed over are 

saved as a mask. These easily and 

precisely set masks serve as the basis 

for seven important image enhance-

ments: “Shading", “Illuminating”, “In-

tensifying Colour”, “Reduce Colour”, 

“Strengthen Details”, “Reduce Details” 

and “Sharpen”, etc …  

These masks can even be saved as its own image file and used in other 

photo editing programs.    

How it all works is probably easiest to explain with an example. Open the 

selective drawing window (post-processing, finalise - bottom right). Our 

example is a single image file of a typical twilight on the beach. The pic-

ture’s colour details are already well edited.  
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Now we want to slightly brighten the rocks without taking away the even-

ing mood; the sky, water and beach should not be brightened.    

 

 Quickly finalize your image with Selective Painting  

1. Select editing objective  

For this case, select “Illuminating”. Make sure that the selected mask 

function is activated and the green checkmark is showing.    

 

2. Activate drawing mode   
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3. Activate filling mode  

4.  Run the mouse over the contours without clicking. You can 

decide and correct the brush size afterwards. 

 

 

5. Now look at the mask display. The object where the borders 

were automatically recognised is now depicted. Click and hold, 

and then trace your mouse along the edges of your chosen ob-

ject until it is completely selected. In the blink of an eye we will 

see the effect as well as the overlying mask.   

 

 

 

 

 

 

 

 

 

 

 

6. Once fully selected, blend the mask out by moving the mask in-

tensity control to the left.   
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7. You will now see only the effect that is brighter rocks - our objec-

tive was “Illuminating”. Now you can adjust the intensity of the 

effect by sliding the control towards the + or -, according to your 

preferred strength. Done: the rocks are brighter while the sky, 

beach and water remain untouched by the editing.   

8. Click on “Close”. You will be returned to post-processing and the 

selective change will be applied. 

 

 

 

 

 

 

 

 

 

 

 

 

9. Use your quickly made mask for a further effect. Go back to the 

selective drawing. Our selective mask has remained.  

 

The rocks on the right are significantly brighter after the selective correc-

tion. The sky and sea still have the same tone values as before.    
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10. Click on      and copy the mask to the clipboard. Switch the 

mask to “Sharpen” and use the  to paste the mask back 

again. Now you have sharpened just the rocks, and the other 

parts of the image were not influenced. 

11. Every selectively applied effect can be activated and deactivat-

ed with the green checkmarks.    

12. Borders have different intensities in every image. Presets nor-

mally do just fine, but sometimes it is necessary to adjust the 

contour and sharpness settings in order to reach perfect fine-

tuned results. 

 

 

13. Have you drawn outside of the lines, despite the border recogni-

tion? You can easily remove it with the eraser.     If you only 

want to remove a small section, use the eraser with limitation. 

When set to 50%, you can only remove 50% of the mask, re-

gardless of how much you erase. The limited drawing mode 

works in the same way, and only draws at a certain opacity. 

 

14. If you want to mask the entire image except for a small object, it 

is a good idea to mask only the small object and then reverse 

the mask by clicking on the  
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Pro Tip: You have two filling modes to choose from when you want to fill 

a mask. When do you use which mask? We used the normal fill mode 

 as in our example for a large surface, which is also preferred for 

water and sky areas 

Ray filling mode    is very precise and favoured for smaller objects, 

geometric forms or subjects with straight lines, like in our example here.  

 

With ray filling mode you can mask just the walls of the skyscraper while 

the window surfaces are not selected.    

 

 

Pro Tip 2:  If you would like to incorporate sections of your original image 

into the edited image, you should work with bracketed series. Recom-

mended here is the use of at least three different exposures.  

 

This dark field will serve as an example: 
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After uploading the bracketed series, select a preset you would like to 

use and make further improvements to it using any of the various editing 

options.  
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The edited version now appears much brighter:  

 

 

Because the edited field appears unrealistic, the darker field from the 

original image is taken. For that you change to the selective painting and 

choose “show original image” as mask function.  

 

 

Adjust the size and opacity of the brush and select the whole field. Now 

you can move the mask intensity control to the left to blend out the mask. 

The field is optimally exposed if you adjust a medium intensity for the 

effect. 
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As a result the field is darker, but there is still a HDR effect recognisable: 
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Functions and Possibilities in Selective Painting  

- Optional mask colours 

Choose for the presentation of the mask as well as the brush one of the 

ready-made colours.  

 

The display will be immediately adjusted to your desired colour. 

 

- Selective Drawing – Creating Masks 

Masks can also be created from a colour or brightness. 

 

With the button (1) you activate the “Create Mask” modus. You will find 

yourself in the standard mode “Create Mask out of Colour”(2). If you want 

to create the mask out of a brightness, chose the (3) button. 

The tolerance controller decides, how sharp (smaller value) or soft 

(higher value) the created mask will be. 

While you are in the “create mask” mode your mouse pointer will turn into 

a pipette. The colour or brightness in which your mouse pointer is set, will 

determine the type of mask being created. 
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In the above example we can see how a red mask has been created for 

the sky. 

Tip: If you want to combine several colours in one mask, simply click on 

the desired colours after each other with the pipette on the screen. The 

current colour will with every click be added to the current mask. 

 

- Selective Drawing – Smoothing Brush 

The smoothing brush (1) gives you the opportunity to draw selective 

areas of the mask softly.  

 

To draw an area even softer, just go over the same area with the smooth-

ing brush several times. 
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- Global Mask Functions 

In the area of global mask functions are several special modes that one 

can use directly.  
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1. Reducing the entire mask outline 

 becomes    

 

2.  Increasing the entire mask outline 

 becomes  

 

3.  Soft-focus effect on the entire mask 

 becomes  

 

With global functions there are two buttons – the left button fulfils the 

function with a lower effect while the one on the right with a bigger effect. 
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- To reset the function of a mask 

Every mask can without any influence on the other masks be reset to its 

original state. You simply click on the waste paper button (1). 

 

After clicking on the button a security query will follow, so that no im-

portant work can be lost by accident.  

 

- Adaptation of automatic masks onto the “Distortioncorrec-

tion” of the RAW module 

Selective drawing works directly with the RAW module. This includes the 

“Distortioncorrection” that is part of the RAW module and that is applied 

completely automatically on several drawn masks. 
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In the example we have an image, where the sky has already been 

masked. 

When we now subsequently correct in the RAW module the horizon 

within the image, then the drawn mask will automatically adjust itself to 

the “Distortioncorrection”. 
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 New in HDR projects 2018 professional  

The new module in Selective Painting from HDR 

projects 2018 professional gives you the possi-

bility to add various textures and materials to your 

images.  Clicking on the symbol to the right will 

display the texture selection.  

Here you can find the 64 different textures you 

have at your disposal. These can be applied to 

your image on up to 16 different layers.  

Clicking on the Zoom Field will show all 64 

different textures at a glance and allow to 

choose between them.  

 

 

For this, simply click on your preferred texture and use the Selective 

Paintbrush to apply it to your image.   
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In the 

Menu at the right of your screen you are given the possibility to further 

adjust your chosen textures according to various parameters. The editing 

possibilities available here include options such as Brightness, Contrast, 

Zoom, Reflected Light, Image Structure, Distortion and Color Variation.  

In addition to these, Selective Painting also includes a module for creat-

ing your own textures using your own individual design. Here you can 

choose between four different automatic edge alignment procedures.  
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Another possibility is to import or export textures from the texture data-

base. Simply click on the corresponding button and choose between the 

import and export functions.   

 

The Flowers texture was applied to make the bottom layer more interest-

ing. 
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13. Composing Mode 

 

In the Composing mode of selective 

drawing you have the opportunity to 

build up to 4 levels of images into 

your current motif. 

To switch into the composing modus, 

click on the “composing” button (1). 

From the list of choices (2) you can 

choose with which composing level 

you want to work with. 

With the button (3) you activate the 

currently chosen mask. Now you can 

through a click on the frame of the 

image (4) upload any image you wish 

to create the next level. 

You can use RAW images, Jpg, Tiff 

as well as several other image for-

mats. 

Underneath the display screen you 

will find the parameter area that be-

gins with two buttons with the follow-

ing functions: 
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(5) Multiple application 

Reduce the size of the image on a different level than the one that you´re 

currently working on. With this option you will be able to stretch the re-

duced image outwards (up, down, left, right). 

 (6) Determine the width-to-height ratio 

This function allows you to determine the width-to-height ratio of the 

uploaded levels, since the width-to-height ratio in an uploaded image 

level can differentiate from the current image you´re working on. This 

preserves the proportion of the levels. 

 (7) Horizontal Reflection  

This function allows the image layer to be mirrored horizontally. This 

enables more precise adjustment to the current image without having to 

make changes to the image layer.  

(8) Vertical Reflection 

This function allows the image layer to be mirrored vertically. This ena-

bles more precise adjustment to the current image without having to 

make changes to the image layer.  

 (9) The Control-parameter 

Width-to-height ratio: If the width-to-height ratio isn´t fixed with the 

button (6), you will be able to change the width-to-height ratio however 

you desire. 

Zoom: Choose the size of that image level by zooming in or out 

Shifting horizontally: Move the image level to the left or right 

Shifting vertically: Move the image of that level up or down. 

Exposure to light: Regularly the light from your current image does not 

match with the exposure of your other image levels. Here you can adapt 
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the exposure and darken or brighten the images however you want, so 

that they match. 

 

A night image with a not very fascinating night sky... 

 

....you can change within a minute with the help of composing into 

an eyecatcher. 
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14. Edit Weighting with HDR Painter    

 

HDR painter is a powerful tool to manually adjust certain areas by editing 

individual images of a bracketing series 

 

 

Exposure Bracketing View (left):  The individual images of a series are 

sorted into red, green and blue. When the bracketing has more than 3 

exposures, the master image will be set as green and the next active 

neighbouring images as red and blue. If you would now like to make 

changes to the weighting of a particular image, pay attention to the 

image’s colour and choose the respective colour in the paint symbol bar. 

 
 

To clarify: The brush does not mean that you paint colours goes onto the 

image, rather that you can adjust the brightness weighting in certain areas 

of individual images. For example, an HDR result shows a landscape 
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where the exposure is correct everywhere, except the tree in the fore-

ground is too dark. Here you can select the brightest image from the se-

ries and enhance the brightness of the tree by “painting” on the object. 

The final fusion is a balanced image with a correctly lit tree in the fore-

ground.    

 

Adjusted Weighting:  

After drawing, the adjusted weighting can be seen to the right of the 

individual image. The white 

drawn strokes mean that you 

have emphasised the tree in 

the brightest image and that 

the tree will be brighter in the 

HDR result.   
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The tree was selectively brightened, without touching the brightness of 

the sky, clouds or plains. The diffused brush makes the transitions 

invisible. The result is a properly weighted image with a correctly lit tree in 

the foreground. The well structured sky remains in the background.   

 

 

 

 

 

 

 

 Important tools of the HDR-Painter: 
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Increase weighting Draw on the selected area to       

                                           enhance the weighting of this   

                                                       portion of the image.   

 

 Reduce weighting  Draw on the selected area to       

                                             reduce the weighting of this portion of 

the image.   

 

 

 

Brush size Adjust the size of the brush.    

 
 

 

Brush form With numerous new brushes, 

you     ………………..will find the 

       right form for your selected 

 …..area.  

 

 

 Stamp   The stamping mode not only edits 

                                              the weighting of the current image, but 

adjusts the weighting of all of the 

other exposures accordingly. For ex-

ample, if you use the paint tool to in-

crease the weighting of an area in 

one image, the weighting of that 

same section will be reduced in all of 

the other exposures to amplify the ef-

fect. 
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 Blurring  If you want soft transitions be 

  ………….tween corrected and original areas, 

……………………………………..trace the blurring function 

over ……………………………………..the borders to soften the 

transitions. 

 

HDR-image/weighting This function mixes the view between 

the HDR image and the 

weighting.This is very effective for 

maintaining control while drawing. 

 

 

 

Delete weighting         Delete the drawn weighting  

for the active image of the series.    

      

 

 

 

Delete all:    Warning: This function deletes all of 

the drawn weightings and returns to 

the initial settings. 
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15. Ghosting Removal with HDR Painter 

When we manually adjust parts of images, it naturally has an effect on the 

program’s ghost image correction. Ghosting can occur when capturing a 

bracketing series of a scene where people or vehicles are in motion and 

thus captured at a different position in every shot. Without the automatic 

ghosting removal from HDR projects 2018 professional, the moving 

objects would appear at a different position in every image, thus causing 

a ghost-like effect.   

Manually removing ghosting:   

The following example illustrates how HDR painter can eliminate the 

regular problem of people walking through a bracketing series.   

Here is the example after being uploaded and without ghost removal:   

 
 

Looking at the image, the people on the left and right are immediately 

recognisable as ghost images.   
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Let’s remove the ghosting as follows:  

1. Find the image in the series displayed on the left that comes 

closest to the brightness of the HDR image. This is usually the 

master image or one above/below.   

2. Select the button for the appropriate colour for this photo, and 

HDR projects 2018 professional will allocate red to this image 

and automatically open the HDR drawing mode. 

 

 

 

3. Select the “Increase Weighting” function and activate stamping 

mode.    

 

 

4. Draw over the people by carefully dabbing with the brush. 
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5. Select the “Blurring” button and stamping mode.   

 

6. Carefully trace the edges of the correction with the blurring brush. 

Done!  

 

Switch to tone mapping and select the “Natural sharp” preset to see the 

result.    

 

 

 



HDR projects 2018 professional – User manual 

 

123 

 

The ghosting has disappeared from the HDR image!  

Tip: “Dabbing” the brush is the optimal method for best results.   

If you would like the program to automatically remove ghosting or you 

have simply forgotten to activate the ghosting removal in the HDR prepa-

ration when loading the images, click on this button  to start a new 

evaluation.   

Warning! A new evaluation eliminates all manually removed ghost-

ing!   
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16.  Workflow 

 Edit final image further in an external program  

HDR projects 2018 professional offers interaction with external pro-

grams. That way you can take a successful HDR result to another photo 

editing program and continue there.   

 

 Open in other projects programs  

Click on the “Projects” symbol in the toolbar to open the image in a differ-

ent program from the projects series. Use the drop-down menu beside 

the symbol to choose one of the programs that you already have installed 

on your computer. 

 

 

 Open in other photo-editing programs 

To directly open the image in 

another photo editing 

program, such as Adobe 

Photoshop, click on the 

corresponding button in the 

symbol bar.   

If necessary, go through the 

settings to show the path to 

the program.  
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Click on “Extras” in the menu and select “Settings” in the drop-down 

menu:  

 

Next, click on the “Export” tab. You can enter the name of a photo editing 

program here, and save it for later as well.    
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 Work with a timeline and restore points 

This option can be found in the symbol bar at the top edge of the screen: 

 

 

“Create Restore Point” saves an in-between point of the current settings. 

You can now always return to this stage of your editing. You can save as 

many editing restore points as you like. The timeline displays the restore 

points and makes it possible to call up any phase with just a single click:   

 

 

This function is especially useful when, for example, you are satisfied 

with an image, yet want to continue trying out different settings and ef-

fects. Simply set a restore point and carry on editing your picture. If you 

want to go back, simply click on your restore point  in the timeline.    
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17.  Selecting and Saving Sections of Im-

ages 

To save a final image, click on the button in the toolbar, go through the 

file menu or use the corresponding keyboard shortcut (Ctrl+S).   

 

 Cropping and captions  

As soon as you have initiated to save a file, the cropping and caption 

window will open. If you would not like to crop or add a caption to your 

image, click on continue.  

 

At the top are several practical aids for perfect image composition and 

cropping.   

You can set the aspect ratio and activate guidelines like the rule of thirds, 

the golden section or the golden spiral.  Practical is also the new photo 

centre display that you can obtain by simply clicking on this but-

ton. 
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The centre of the window shows your final image. Fix the area to be 

saved by adjusting the corners and borders of the photo.   

At the bottom is an option to enter a caption. You can determine the size, 

position and background for the text. 

The size of the text will be automatically coordinated to the final cropping. 

 You can either crop free-handedly or use one of the 71 provided formats.    

 

Please note: If you choose the 

cropping, e.g. 13 x 18, the final 

image will not be saved as 13 x 18 

cm, rather as a ratio of 13 to 18.    

 

 

 

 

 

 

 

 

As soon as the image has been cropped and captioned, confirm the save 

and the following window will prompt you to select a file format and name 

your file.   
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18.  RAW-Processing 

You can upload and edit RAW image data with the integrated RAW 

mode. Numerous tools are available to you here, such as de-

noising/sharpen, exposure, colour and detail as well as powerful distor-

tion capabilities.    

 In this RAW mode changes that are made will be transferred onto the 

entire bracketing series, so that you only have to put in the settings once. 

Resetting the category: 

Every category can through a click on the reset-button (bottom left) be 

reset to its original state without influencing the settings of the other cate-

gories. 
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An overview of the most important RAW functions:   

White balance: Here you can regulate the colour temperature. Use the 

pipette to select a white balancing colour directly from the image.    

Denoising/ Sharpness: This feature regulates the image’s noise and 

sharpness. Control the quality and different types of noise such as colour 

noise, banding or hot pixels.   

Colour balance/ white balance: Here it’s all about colour and 

black/white correction. Modify the general colour mood and neutralise 

white and black - the icing on the cake for professional colour correction.    

Exposure: Influence lights, shadows, contrast and brightness in the final 

image. With the new dynamic brightness you can adapt the light to the 

contents of each image individually. 
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Detail: Fine-tune clarity and micro-details with lights, shadows and mid-

tones.    

Colour: These colour settings are all about the luminosity of lights and 

shadows. You can even reduce the presence of unwanted chromatic 

aberrations.    

These light diffraction corrections allows you to purposefully remove the 

chromatic aberrations of a certain colour.Thereby a lens curve will be 

calculated backwards on top of the colour channel.  

Palate: Adjust the saturation of individual colours.   

Distortion: Take a closer look. These mighty tools can straighten out the 

horizon, correct camera angles and lens errors. Use “Autofit” to automati-

cally trim any awkward borders.    

The reference grid can be adapted in the distance between the grids as 

well as in its transparency. This is how you will always have the maximum 

overview when you are correcting your settings. 
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 Category FX: 

 

This category includes a several new 

special effects like a mist & fog cor-

rection, save highlights, sepia and 

film grains as well as different gradi-

ents. 

Pro Tip: 

When you take a landscape shot, 

shift the controller to “Gradient top” 

to a dark tone and create in that way 

a neutral thick (ND) – process filter. 

 

General:  

Activate the “360° panorama mode” 

to optimise matching edges of imag-

es in a panorama series. Save your settings as a camera profile to save 

time in the future. This can be reset at any time.    

 

If you have conducted the settings in RAW mode, click on “apply”. 

If you save your settings in the camera profile, you will save a lot of time 

for future photographs. The settings can be reversed at any time.   
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19.  Batch processing 

HDR projects 2018 professional’s batch processing allows for auto-

matic processing of multiple bracketing series. The function can be found 

in the drop-down menu for “Extras” in the menu bar.  

Here you will find two types of batch processing:  

a. Batch processing HDR + tone mapping  

b. Batch processing HDR fusion 

 

 a. Batch processing HDR + tone mapping  

First, choose the source folder where the individual images (HDR from 

one exposure) and/or the bracketing series are located. The files can 

also be mixed, since the system will automatically recognise and sort the 

bracketing series vs single shots.   

The “Include all subdirectories” checkbox not only searches through all of 

the selected folders, but also all subfolders and their further subfolders.   

Batch processing: Renaming and sorting 

In the area of the target folder you will be able to activate the “sort mode”. 

You set thereby the batch processing in the renaming and sort mode. 

 



HDR projects 2018 professional – User manual 

 

134 

As soon as the sortation mode is active, new push buttons will appear. 

File name filter:  

Here you can insert a file name for renaming the image with the help of 

Syntax: 

-Text 

##.# for the number of bracketing series, the number of # signs gives the 

number of places of numbering 

-Text 

##.# for the number of images within the current bracketing series, the 

number of # signs shows the lists the number of places that are num-

bered. 

The file name “Shooting072016_####_##” creates image data in the 

form of: 

Shooting072016_0001_01.cr2, Shooting072016_0001_02.cr2, … , 

Shooting072016_0002_01.cr2,  Shooting072016_0002_01.cr2, … 

Note: To sort your image data into the data carrier without renaming, 

leave the file name simply empty. 

 

Deleting the original file 

This option you should only use if you are absolutely sure that your inser-

tions are correct. 

The original data of the image will then be deleted. Only the newly 

changed sortation and names will remain, the original data of the image 

will then have been deleted. 
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Install a subdirectory per sequence: 

When this function is active, every bracketing series gets its own subdi-

rectory. 

 

Note: Remember that looking through folders with several subfolders can 

require a lot of time. That’s why selecting “C:\“ is not recommended. 

 

 Allocation and automatic bracketing recognition  

This feature takes on all of the work for you. Now you can choose be-

tween different modes:    
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Automatic allocation: Loads all of the images and based on the images’ 

content, locates those that belong to an exposure bracketing series. The 

brightness as well as the coverage are compared, which results in very 

good automatic recognition.    

Individual images: The “Individual images” option sorts every image 

into its own bracketing series. This setting is very well suited for editing 

image sequences, for example, those generated from footage. 

2 image to 9 image groupings: Select this option if you have taken 

HDR films or are certain that the bracketing series in your folder all con-

tain the same number of shots. The file names for the final images will 

automatically be successive, so that the edited images can be directly 

used in a video editing program.    

Results: Here you can set where the resulting images of the batch pro-

cessing will be saved. Select the corresponding folder with the “Target 

directory (. . .)”  button or enter the name of the folder directly into the text 

box.   

Format: You can choose from nine different formats to save your result-

ing images. With .jpg, .tif and .png, there are two 8-bit formats (LDR) and 

four 16-bit formats (HDR). JPG images are always the highest quality and 

TIF files are saved uncompressed and without defects.  

For further web editing, the final images can be saved in Open EXR as 

well as in Portable Floatmap and Radiance RGBE. 
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 Processing settings        

Select the settings for the HDR preparation and tone mapping here. 

These apply to all of the bracketing series in the batch processing. 

HDR default settings: The HDR default settings offer three to four pre-

sets for every HDR algorithm. Simply select your preferred preset from 

the list.   

Post-processing: The presets contain all post-processing/tone mapping 

presets, including all of the presets from your “Custom" category that you 

designed yourself. You can also choose a special preset before batch 

processing and apply it to multiple bracketing series. As soon as the HDR 

presets and post-processing switch, all of the preview images in the 

bracketing series will be recomputed, so that you always see a real view 

of the results. 

HDR preparation: Open this dialog to adjust options like colour space, 

white balance, alignment etc.    

Note: Apple computers systematically open this dialog before the batch 

processing window.   

Exposure bracketing view: Here you will find information about the 

located bracketing exposure series.  
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At the top of the display is the number of listed bracketing series. Directly 

below it are three buttons for global activation and deactivation of series.   

Activate all exposure bracketing: Activate all corresponding bracket-

ing series for the calculation. (Standard setting)  

Deactivate all exposure bracketing: Deactivates all assigned expo-

sure bracketing for the calculation.   

Remove single images: Removes all exposure bracketing for single 

images from the calculation and display. You can use this option if the 

program develops a very bright or very dark image incorrectly, or if you 

have taken photos that should not be processed by HDR. 

 

 Batch processing for HDR fusion  

In HDR fusion batch processing, you calculate the image stacks for the 

pure fusion HDR images without applying any post-processing or tone 

mapping filters. 
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These methods make the most sense when you want to edit the fused 

results further in other programs or want to create and save pure 32-bit 

HDR formats.    

The available lossless final formats:  

-       Radiance RGBE (.hdr)  

-       Open EXR (.exr)  

-       Tiff 32-bit (.tif32)  

-       Portable Floatmap 32-bit (.pfm) 
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20.  Via GPS coordinates directly to Open-

StreetMaps 

If the GPS coordinates are in your Exif-files (Menu -> Exif information), 

then you will be able to locate the place where the photo was shot when 

you click on the button “Open GPS coordinates via Browser”. You will see 

the place the photo was shot in www.OpenStreetMaps.org. 

 

 

 

 

http://www.openstreetmaps.org/
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21.  Add-ons 

With help from add-ons, you can not only import presets from HDR pro-

jects 2018 professional, but also entire post-processing modules can 

be integrated, which can be necessary to create new preset looks. If you 

have bought one or several add-on-packets in our shop, install the add-

ons like this: 

1. Extract the files from the downloaded zip folder  

2. Öpen your HDR projects 2018 professional version.  

3. Click on menu  Add-ons  Import Add-ons 

 

4. Select the folder of the Add-on in the following dialog window, 

open it with a double-click and select the file with the suffix 

.praddon aus. Then click "Open".   
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5. The add-on will now be imported. A confirmation message will 

appear:   

 

 

6. Please close and restart the program to be able to use the add-

on with all of the other presets.  

 

7. Open HDR projects 2018 professional and load an image or a 

bracketing series. Switch to post-processing mode (palate sym-

bol). If you are the owner of HDR projects 2018 professional, 

you will automatically be 

sent to post-processing 

mode. Select Menu  Add-

ons  Add-on Information 

and confirm that your filter 

package was successfully 

activated. 
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8. Filter selection can be found 

on the left-hand side, direct-

ly under the import/export 

buttons.  

Here only the new, recently 

imported presets are dis-

played. 

 

9. Click the arrow to open the 

dropdown menu and select 

"Lost Places". Now exclu-

sively the new presets will 

appear on the left display 

box.    

 

 

10. If you would prefer to not fil-

ter the presets, the new pre-

sets can be found in the 

"Architecture" category. The 

"Lost Places" presets have 

"LP" in their names to be 

easily recognisable.    
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22.  Plug-in Installation 

HDR projects 2018 professional can also be used as a plug-in for 

Adobe® Photoshop. Newer versions of Photoshop are automatically 

detected by HDR projects 2018 professional during installation and 

the plug-ins are installed in the respective plug-in folder. Older versions 

of Photoshop might require manual installation.  

 

If you purchased your software as a download or if you have lost your 

CD, the plug-ins are also available for download at: www.projects-

software.de/plugins  

 

22.1 Using Photoshop Plug-Ins in Windows 

The following window will appear when installing HDR projects 2018 

professional  

 

Select the version of Photoshop where you would like to install the HDR 

projects 2018 professional plug-in. Click on “next” and follow the in-
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structions from the installation assistant. The plug-ins will then be auto-

matically installed.   

  

Please note: When using older Windows systems, it can occur that not 

all Plug-ins are automatically installed. Should this occur, simply copy the 

preferred Plug-in directly into the appropriate folder of your current Pho-

toshop version as shown in the picture below. Should you be using an 

older Photoshop version, simply copy the lowest Plug-in.  

Example: Photoshop CS6 users should copy the Plug-in for Photoshop 

CS6 and not Photoshop CC 2014. In this case CC 2017. The corre-

sponding Plug-in can be found on the CR-ROM under “Plugins”.   

The folder can be found under C:\Programme\Adobe\Adobe Pho-

toshop CC 2017\Plug-ins  

 

You can also complete the Plug-ins installation at a later date. Please 

install Photoshop before attempting to install the Plug-ins! Follow-

ing installation of the Plug-ins, please reopen Photoshop.  

In Photoshop under the menu tab “Filters” you will the entry Franzis. All 

Plug-ins from the projects-collection can be found listed here.  
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Click on HDR projects 2018 professional. The image opened and 

edited in Photoshop will now be opened in HDR projects 2018 profes-

sional.  

 

The program now finds itself in Photoshop Filter Plug-in Mode. You can 

edit the photo in HDR projects 2018 professional just as usual. Once 
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you are done editing, you can send the finished version back to its origi-

nal Photoshop Layer by clicking on “Apply”.  

 

The “Cancel” button closes the Filter Plug-in without sending the chang-

es made to the image back to the Photoshop Layer. Changes made in 

HDR projects 2018 professional are therefore discarded.  

 

The project program will then automatically close itself. This mechanism 

is conducted by Adobe Photoshop and cannot be stopped. 

22.2 Using Photoshop Plug-ins with MAC OS X 

Plug-ins can be found on the start screen in the “Plug-ins” folder. Select 

the appropriate folder for your version of Photoshop (we chose Pho-

toshop CS6 for our example). Double click the .zip file to extract the plug-

ins. 

Next, drag & drop the plug-in HDRpro-

jects2018ProfessionalFilter_PH6.plugin (PH7 with other Photoshop 

versions) to the plug-in folder for your version of Photoshop, which is 

normally labelled as “plug-ins”: 
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Start up your version of Photoshop, load an image and navigate to 

„Menu Filter Franzis HDR projects 2018 professional“ 

 

One click will start the plug-in. With a click you start the Plug-In. The 

image will now be opened in HDR projects 2018 professional. 

 

Now you will find the program in Photoshop Filter-Plugin mode. You will 

be able to edit the image as you´re used to in HDR projects 2018 pro-

fessional. 
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When you´re finished editing the image you can send the image directly 

back to Photoshop by clicking on the button “apply”. 

 

With the button “discard” you finish the filter Plug-in, without sending the 

changes that you have done to the image back to the Photoshop level. 

The editing that you have done in HDR projects 2018 professional will 

be discarded.  
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The project program will then automatically close itself. This mechanism 

is conducted by Adobe Photoshop and cannot be stopped. 

 

22.3 Using Adobe Lightroom Plug-ins - Windows 

 

Start the installation program and check in the component selection if 

“Lightroom Plugin” has been chosen 

 

If you have no CD, the plug-in is also available for download at: 

www.projects-software.de/plugins. 

 

Subsequently open your Lightroom version. Start Lightroom and navigate 

to „File Plug-in (Zusatzmodul) manager“ to check if the plug-in 

has been activated. 
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Should this not be the case, you have the additional possibility of manual-

ly installing the Lightroom Plug-in by clicking on “Add” option found in the 

Plug-in Manager.  
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To do this, navigate your way to the Plug-in folder containing Ap-

pData/Roaming/Adobe/Lightroom/Modules/HDRProjects2018Pro.lrplugi

n  

 

As soon as you find yourself in the folder labeled HDRPro-

jectsPro.lrplugin, click on the option “Choose Folder” to install the Light-

room Plug-in.   

 

Lightroom: HDR projects 2018 professional: Installed and executed. 

 

Mark a bracketing series in your lightroom library.  

 

Right-click on the image directly in Lightroom and select „Export 

Export to HDR projects 2018 professional“. 
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Or: Choose „File Export with Preset Export to HDR projects 

2018 professional“. 
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22.4 Using Adobe Lightroom Plug-ins - MAC OS X 

The Plug-In for Adobe Lightroom will not be automatically installed with 

MAC OS X. To integrate it into Lightroom, continue as follows:   

Install HDR projects 2018 professional to the program link of your Mac.  

Copy the plug-in .zip file from the “Lightroom Plug-in” folder on your 

CD-ROM. We recommend the folder where also your presets are stored:  

„Users/username HDR projects 2018 professional“. 

Start Lightroom und navigate to „File Plug-In Manager“. 
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Click the “Add” button in the Lightroom Plug-In Manager.   
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Choose the relevant Lightroom-Plug-In of HDR projects 2018 profes-

sional that you have just copied to your computer, by navigating towards 

it. 

 

If the Plug-in is not instantly marked with a green active dot, close Light-

room and start it again. 
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Now the Plug-In should be installed and be up and running. 

You have now several options to get your image from Lightroom to HDR 

projects 2018 professional. 

„File Export with file Export to HDR projects 2018 profes-

sional“. 
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OR:  

 

Right-click on the image directly in Lightroom and select „Ex-

portExport to HDR projects 2018 professional“. 
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23.  Keyboard Shortcuts 

Overview of the integrated Keyboard shortcuts 

In the main menu in the area of information you will find an overview of all 

available keyboard shortcuts.  

 

Click on this item to open the overwiew: 

 

In the overview you will be able to scroll through the different areas, 

where you can take shortcuts. 
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General: 

Windows Apple 

Ctrl N  cmd N New Project 

Ctrl  Shift O  cmd Shift O  Upload Single Image 

Ctrl  O cmd O Upload Image Sequence/Bracketed Series 

Ctrl  S  cmd S  Save Image Result 

Ctrl  D  cmd D  Print Image Result 

Shift Z  Shift Z  Create Undo-Point 

Ctrl  T  cmd T  Open Timeline 

Ctrl  F4 cmd F4 Quit Program  

F4 F4 Open RAW Module 

F5 F5 Edit Image Sequence/Bracketed Series 

F6 F6 Edit Weighting 

F7 F7 Switch to Post Processing 

Ctrl  P  cmd P  Open Settings 

Ctrl  B  cmd B  Open Batch Processing 

@  Access Homepage 

Shift F1 Shift F1 Open About Dialogue 

Ctrl  I Ctrl  I Show Information Section 

Ctrl  E  cmd E  Show Exif-Information 

Ctrl  H  cmd H Show/Hide Histogram  

Ctrl  F  cmd F Fullscreen Display 

 

 

Display Functions: 

Windows Apple 

Ctrl  + cmd + Zoom in 

Ctrl  - cmd - Zoom out  

Ctrl  0 cmd 0 Fit Image to Screen 

Ctrl  1 cmd 1 100% Display View 
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R  R Real-time Mode on/off 

L  L Configure Radar Window (lock) 

 

RAW Development: 

Windows Apple 

Ctrl  + cmd + Zoom in 

Ctrl  - cmd + Zoom out  

 

Progress Browser: 

Windows Apple 

Image up  Image up Back one page 

Image down Image down Forward one page 

Pos1 key Pos1 key  To the Beginning 

End key  End key  To the End 

Cursor left  Cursor left  Previous Item 

Cursor right  Cursor right  Next Item 

 

 

Variation Browser: 

Windows Apple 

Ctrl  + cmd + Zoom in 

Ctrl  - cmd - Zoom out  

Cursor left Cursor left  Shift View to the Left  

Cursor right Cursor right Shift View to the Right  

Cursor upwards Cursor upwards Shift View Upwards  

Cursor downwards Cursor downwards Shift View Downwards  

Ctrl  0 cmd 0 Show All  

Space Bar Space Bar Center View 

Enter Key Enter Key Select Item 

 



HDR projects 2018 professional – User manual 

 

164 

Weight Painter: 

Windows  Apple 

1 1 Choose Red Brush Tool  

2 2 Choose Green Brush Tool  

3 3 Choose Blue Brush Tool  

Ö Ö Increase Brush Size  

# # Reduce Brush Size 

Ctrl  G cmd G Calculate Automatic Ghosting Correction 

 

 

Sensitive Selective Painting: 

Windows  Apple 

Ctrl  +  cmd + Zoom in 

Ctrl  -  cmd -  Zoom out 

Ctrl  O cmd O 100% Display View/Adjust Fit  

A  A Activate Brush Tool  

Shift A  Shift A  Activate Brush Tool with Limit 

S S Activate Eraser Tool 

Shift S  Shift S  Activate Eraser Tool with Limit 

W W Activate Blur Tool  

E  E Activate Image Mask Creator  

D  D Activate Fill Mode  

F  F Activate Brush Fill Mode  

R  R Activate Brush Streak Mode  

1 1 Reduce Brush Size 

2 2 Increase Brush Size 

3 3 Reduce Opacity  

4 4 Increase Opacity  

5 5 Soften Outline Recognition 

6 6 Sharpen Outline Recognition 
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7 7 Reduce Blur  

8 8 Increase Blur  

Ctrl  Z  cmd Z Back One Step   

M, Shift M  M, Shift M  Mask Display On/Off 

 

Scratch and Sensory Error Correction: 

Windows Apple 

Ctrl  + cmd +  Zoom in 

Ctrl  - cmd -  Zoom out  

 

Cursor left, Shift Cursor left, Ctrl  Cursor left  Move Active Correction Region left  

Cursor right, Shift Cursor right, Ctrl  Cursor  Shift Active Correction Region right 

right   

Cursor upwards, Shift Cursor upwards, Ctrl   Shift Active Correction Region upwards 

Cursor upwards  

Cursor downwards, Shift Cursor downwards, Shift Active Correction Region downwards  

Ctrl  Cursor downwards 

Image up  Image up Select Previous Correction Region 

Image down  Image down Select Next Correction Region 

C  C Activate all Correction Regions 

N  N Set New Correction Region 

Entf  Entf Delete Correction Region  

+ + Enlarge Active Correction Region  

- - Minimize Active Correction Region  

 

 

Selective Editing: 

Windows  Apple 

Cursor left, Shift Cursor left, Ctrl  Cursor Shift Selective Editing Region left  

Cursor right, Shift Cursor right,  Shift Selective Editing Region right 
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Ctrl  Cursor right 

Cursor upwards, Shift Cursor upwards, Ctrl  Cursor Shift Selective Editing Region 

upwards 

upwards 

Cursor downwards, Shift Cursor downwards,  Shift Selective Editing downwards 

Ctrl  Cursor upwards 

Image up  Image up Select Previous Correction Region 

Image down  Image down Select Next Correction Region 

Entf Entf Delete Active Correction Region  

1 1 Hide All Masks 

2 2 Show Active Selective Editing Region Masks  

3 3 Show All Selective Editing Region Masks 

 

 

Image Cropping: 

Cursor left, Shift Cursor left, Ctrl  Cursor left Shift Cropping Region to the left 

Cursor right, Shift Cursor right, Ctrl  Cursor  Shift Cropping Region to the right 

right   

Cursor upwards, Shift Cursor upwards,  Shift Cropping Region upwards 

Ctrl  Cursor upwards  

Cursor downwards, Shift Cursor downwards, Shift Cropping Region downwards 

Ctrl  Cursor downwards  
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24.  Integrated list of supported RAW formats 

In the main menu in the area information you will find an integrated list of 

supporting camera RAW-formats sorted by manufacturer.  

 

If you chose this menu item a camera RAW-format window will open. 

 

In the top area of the window you will find a selection of choices, with 

which you will be able to filter the list for singular camera manufacturers. 

This way you will find your camera faster. 
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To have constant access to the supporting camera RAW- formats via a 

separate window, you can use the function „open in browser“(window 

bottom left), which will show the list in a standard browser. You will also 

be able to print the supporting RAW-formats from there. 
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Hotline/Support 

Contact the FRANZIS Customer Service Team for questions about installation, problems or 

disruptions concerning this software product.  
 

E-Mail: support@franzis.de  
 

Telephone (Monday - Friday 12-18:00): +49 (0)180 30 02 644  

(0,09 EUR per Minute from German Landines, mobile rates may vary) 

 

Telefax: 0180 300 26 45 (0,09 EUR per Minute from German Landines, mobile rates 
may vary) 

 

Please bear in mind that your inquiries can only be handled by the FRANZIS Customer Service 

Support Team. This is how we can continue to make lasting improvements in our service 
quality while answering your questions quickly and professionally.  

Customer Service quick and easy: 

Have important information concerning your PC system and product ready: 

 Product Name 
 Product-ISBN-Number (These can be found on the back side of the product 

packaging located above the bar code). 

 Operating System of your PC 

 Information about your PC’s Configuration 
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